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A meeting of your board of directors  was
held on Wednesday, November 14, 2012.

The meeting was called to order at 7:20 PM
Attending were Richard Corzo, Annette

van Ommeren, Andy Woodruff, Elizabeth
Talian, Jim Scheef, Bruce Preston, Lisa
Leifels, Richard Teasdale. Guest: Charlie
Bovaird.

The minutes of Last Meeting were
accepted as published.

TTTTTrrrrreasureasureasureasureasurer’er’er’er’er’s Rs Rs Rs Rs Reeeeeporporporporporttttt
Balance on hand 10/1/12  $5,444.69

INCOME
  Dues $210.00
  Bank Interest $0.24
    Total Income: $210.24

EXPENSES
  Resource Center Phone $80.40
 Newsletter Postage $45.50
  Renewal Letter Postage $5.76
 Door Prize for October $30.84
 DSL ISP Service (15 months) $585.00
    Total Expenses: $747.50

Balance on hand 10/31/12 $4,907.43

Membership Report
General Meetings

Sep:  - Google Voice, etc.
Oct: - Os X Mountain Lion
Nov: Mobile Apps Dev

                            SEP  OCT  NOV
Paying Members                128    129    129
w/ e-mail addresses            113    114     116
New Members                       0        1        0

DACS.DOC

Printed                               100    100    100
Mailed                                 73      72      71
Mailed - Member                  52      51 51
Mailed - Other                        6        6 6
Mailed - Free Library           14      14 14

Attendance
Seat Count                             45      37    27
Members Signed-In               37      27    26
Visitors Signed-In                    6        8  1

Old Business

1. General meetings

• November 6: Joe Mazzeo & Dr.
James Marcus - Trends in Mobile
Apps. Preview: Bruce Preston, Re-
view: Lisa Leifels

• December 4: Jay Ferron - Win-
dows 8. Preview: Jim Scheef, Review:
Richard Corzo

• January 2 (WEDNESDAY): Marc
Polansky from McCarthy Observa-
tory - Astronomy and Computers.
Venue is to be determined. Preview:
Allan Ostergren, Review: Richard
Teasdale

• February 5: Drew Kwashnak -
Cloud Storage Services. Preview:
________, Review: ________

• March 5: Toni McKeen - Geneal-
ogy. Preview: ________, Review:
________

• April 2: Laura Nute of Lynda.com
and Kevin Corcoran of CTDLC.org -
Online Learning. Preview: Elizabeth
Talian, Review: ________

• May 7: John Patrick - State of the
Internet. Need to review publicity well
in advance.

• Possible future topics:

° Presentation on Facebook. Jim
has run into a brick wall trying to
reach anyone that can represent
Facebook, either directly or via user
community etc. Lisa found that an
individual in a Hartford business
group had presented on Facebook,
Twitter, LinkedIn, Pinterest etc. and
will investigate further.

° Jeff Robbins - Drupal expert.
Jeff is interested in doing a presenta-
tion but is not able to commit to a
date at this time. Andy will follow up
early next year.

° Twitter? Lisa will look into the
topic. Sean mentioned someone he
knew, Jennifer M. Scott, who uses
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Twitter heavily for her business
(http://www.workforceengine.com/).

° Bruce could do Desktop Pub-
lishing in June or July

° Jay Ferron said he could do a
presentation on Office 2013.

° Years ago we did "Surfin'
Safari" as a segment about interesting
websites. Perhaps now we could do
something similar with mobile
devices - smartphone and tablets - what
apps are found to be interesting, enter-
taining, etc. This could be a 'forum' type
meeting with multiple presenters for a
full session, or it could be a small seg-
ment after AskDACS.

2. Open positions

• The membership chairperson/
greeter position is still open. The
greeter has these responsibilities:

° Sign in members

° Sign in visitors, ask how they
found us

° Accept dues

° Distribute raffle tickets

• Jim Scheef has composed a draft
welcome email to be sent to new mem-
bers. He will submit to board for re-
view by email. Charlie and Jim will
meet to work on the database.

• We need someone to send out
monthly press releases. The press re-
lease need not be as detailed as the
meeting preview, although it would
help if some of the information be
made available to our PR person.
Newspaper lead time for events such
as ours is considerably longer than
the lead time for DACS.doc. We will
shoot for having the information to
the media three weeks in advance.
Richard has an email list from Patrick,
Drew has a file in the Yahoo! group
that has the print addresses we have
used in the past. Richard Teasdale will
take the lists and set up the distribu-
tion process.

3. In addition to our general meeting,
we posted our first SIG meeting (Mo-
bile Devices) on Meetup and got one
new visitor, new to DACS as well. We
will continue to post more meetings
during our six - month signup. Bruce
will compose an announcement for
the MS Access SIG virtual meetings.

Our former telephone HelpLine has been replaced by our web-based DACS
Community Forum at http://forum.dacs.org. We have topic-specific forums where
DACS members can post questions. Questions may be answered by SIG leaders
or other DACS members. If none of the categories fit your question, just post it to
the Ask DACS forum.

Topic Forum
Microsoft Access Access SIG

.NET Programming ASP.Net and C#VB.Net SIG

Digital cameras/scanners/image processing Digital Imaging SIG

Content Management Systems Drupal SIG

Linux Linux SIG

Mac and iPhone/iPad/iPod touch Apple SIG

PC maintenance PC Maintenance SIG

Smartphones & Tablets Mobile Devices SIG

Virtual machine software Virtual Computing SIG

Desktop publishing and website design Web Site Design SIG

Windows Windows SIG
Directors’ Notes, Cont. on page 5
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Meeting Review

Trends in Mobile Apps
By Lisa Leifels

ON TUESDAY, November 6th, we
were very fortunate to have Joe
Mazzeo and Dr. James Marcus from

Crossfire Consulting give us a joint pre-
sentation on the cur-
rent trends in mobile
computing. Crossfire
Consulting is based in
Yorktown Heights, New
York and is a full service
information technology
company that develops
software, places people
in IT jobs, and now of-
fers courses in building
Advanced Websites
and Mobile Apps. One
of the reasons Crossfire
began educating stu-
dents in the latest mo-
bile technology was because they were
having trouble finding people with the
skills they needed to do the work that their
customers demanded.

The meeting started off with a few sta-
tistics showing some of the current trends
from the year 2011:

• Webmail usage was down 32% for 12-
24 year olds.

• Nine out of ten internet users visited
a social networking site each month.

• YouTube served up 4.5 billion videos
per day, which is 1.8 per person per day.

• Android has reached 56% of the
smartphone market, iPhone is second at
31%.

What conclusions can we draw from
these measurements?  Does this mean email
is on its way out?  We’ve often been told
to watch young people to see where tech-
nology is headed. By now most of us have
figured out if you want to get the attention
of a teenager, you’re better off sending them
a text message, instead of an antiquated
email. Facebook and Twitter do seem to be
everywhere you look, and who doesn’t
enjoy watching a video on their handheld
device, which is always with you and much
more convenient. Although there are more
people who own Android devices, Steve
Jobs would be happy to hear that most of
the apps that are purchased are for people
who own an iPhone.

It was interesting to hear the story
about how Jeff Bezos,  founder of Amazon,
was one of the early pioneers of cloud com-

puting. Jeff Bezos started asking questions
about the business, people, and power, and
discovered that hardware and software
make up 82% of his company’s costs. At

one time Amazon had
a data center every-
where they had a ware-
house, which was get-
ting to be expensive.
He realized that the
hardware and software
costs were going to
come down over time,
and that with the use
of virtualization tech-
nology his costs
would eventually be
reduced. A lot of the
utility companies in
many states give busi-

nesses inexpensive rates for power. Data
centers started popping up in the states
that gave away free power. It takes about
7 people to man a data center 24x7x365.
Jeff Bezos consolidated Amazon’s  data
centers to reduce their expenses. Then
he made the wise decision to commercial-
ize what he learned, and in 2002 Amazon
Web Services came into existence. Ama-
zon may have been one of the first compa-
nies to use the cloud, but the cloud is low-
ering the costs for everyone on the web.

Now that the majority of consumers are
using multiple devices, Crossfire believes
in the 1’-2’-10’ design rule, which refers to
the distance between a screen and a
person’s face. A smartphone is usually
about a foot away, the tablet and desktop
computer are about 2 feet away, and a
television is approximately 10 feet away.
First, design your website for a smartphone;
second, design it for a tablet; and finally,
design your site for a desktop, which was
referred to as a boat anchor in the presen-
tation, since you can’t take it with you.
Most people would prefer to be looking at
a website that looks appealing when it is
viewed in a way that is presentable on all
of your devices. In general, mobile con-
sumers use less of the ‘classic’ web, which
consists of webmail, weather sites, map
sites, PDF’s and multi-page documents,
preferring to use apps, video,  Instant Mes-
saging and SMS.

The audience was eager to hear more
about the two courses that Crossfire is
currently offering. The first one is called

Building Advanced Websites & Basic
Mobile Apps, and it began on Septem-
ber 8, 2012. It is held on Saturdays from
9:00 am to 2:00 pm and goes through Feb-
ruary 3, 2013. The second course is
Building Native Mobile Apps for
Android & IOS Devices and began on
September 10, 2012. It is held on
Monday evenings from 5:30 pm to 9:30
pm and goes through January 28, 2013.
The first course is not a prerequisite for
the second, and both are taught at the
Crossfire headquarters in Yorktown
Heights, NY. The next session will be
starting in March of 2013.

The best part of all was finding out
that there is no tuition fee – but keep in
mind that the classes are limited to 40
students on a first-come, first-qualified
basis. And the reality is, nothing is ever
really free. If you do decide to take one
of these courses, you must make the
commitment to attend the classes and do
the homework, which takes approxi-
mately 8-9 hours a week outside of class.
The class is filmed and you do have the
opportunity to review and replay the
parts that you may have missed. The
class is set up to use an Eclipse environ-
ment for version control, which is simi-
lar to most work environments. Their
current students range in age from 21 to
75. Crossfire believes that it’s possible
for anyone to learn this new technology
if they put the time into it. The teachers
at Crossfire were blown away to find out
that after only 16 weeks of class their
students actually got jobs.

It may be human nature to resist
change, but deep down we all know that
we live in a world that is constantly
changing–and if we don’t at least ac-
knowledge this, we will be left behind.
It’s hard not to notice the growing num-
ber of people who are using smartphones
and tablets for working, shopping, and
traveling, and all kinds of tasks that used
to be done on a laptop or desktop. With
the high unemployment rate constantly
in the news, it’s encouraging to hear that
there are job opportunities available for
people who are willing to put the energy
into learning something new. It’s good
to see that a company like Crossfire is
embracing the recent changes and has
transformed itself from a company that
solely created software to a company
that teaches people the skills that are
needed to be successful in today’s
world. If you would like to learn more
about what Crossfire has to offer, you
can go to their website at
CrossfireConsulting.com.
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Meeting Preview

Windows 8 and new Office
By Jim Scheef

Directors’ Notes, Cont. from page 3

4.  Should we start a "Beginners" SIG?
We concluded that it wasn't feasible
for a SIG, but perhaps it would be a
good topic for a 'workshop' that we
hold from time to time. Since it isn't a
SIG it would not have the requirement
for DACS membership, but rather treat
it as a mechanism to generate interest
in DACS membership. Jim volunteered
to do a workshop and Charlie volun-
teered to be an assistant. Date (and
day of week for that matter, including
possibly a weekend) to be determined.

New Business

1.  Six board members are up for reelec-
tion in December. Four plan to run
again: Richard Corzo, Dave Green
(only committing for one year), Rich-
ard Teasdale, and Andy Woodruff.
Patrick Libert and Elizabeth Talian are
retiring, so we need to find two new
candidates. I have contacted one can-
didate so far, but haven't heard back.
Due to reduced membership the board
is considering lowering the number of
board members. The number of board
members is not dictated by the
ByLaws.

2. A new contact at the Microsoft Store
has invited us back for a Windows 8
workshop or seminar. We will look at
having a workshop to be scheduled in
January - any Monday, or  Thursday,
Jan 17th appear to be open, Richard
will explore dates with Microsoft. Note
that as such it will not be a general
meeting.

3. APCUG membership will be renewed.

4. It appears that our ISP service has
changed hands and as part of that bill-
ing was messed up. We got a bill for
past services in addition to the next 3
months. We will investigate switching
our ISP to either cable or whatever
variant of DSL might be provided to
our facility.

5. It has been determined that the call
drop-outs etc. that were happening
during Skype conference sessions
were due to an automatic volume con-
trol setting in some of the computers
being used. Disabling this feature
completely eliminated the call drop-
outs.

Adjourned: 9:05

— Bruce Preston

THIS MONTH, after several preview
versions, Microsoft has released
Windows 8 – the latest version of

Windows. To explain it all to us, our speaker
will be Jay Ferron, CEHI, CWSP, CISSP,
CRISC, MCITP, MCSE, MCT, MVP, NSA-
IAM. Come learn about Microsoft Windows

8 - the newest desktop operating system.
Get an understanding of what’s new and
what’s improved in the new Windows. Jay
will cover it all starting from the hardware
requirements you need to run the new OS.
See the new user interface, security features,
and much more.

Windows 8 introduces a breakthrough
user experience and is designed to help you
feel confident in your ability to view, find,
and organize information and to control your
computing experience. When you start us-
ing Windows 8, you will recognize a com-
pletely new way to work that is now faster,
more streamlined, and more helpful than in
previous versions of Windows. The Tile

base menu features integrated desktop
search, which can help you find and launch
almost anything on your PC. Just type in a
word, a name, or a phrase, and Search can
find the right file for you. But more than
that, the new start menu makes it very easy
for you to navigate across all of the installed
applications on your PC.  Learn the new
desktop tricks that make it easier to work
with multiple documents.

This program will have lots of demos ...
Beyond the new Windows, Jay will

also give us a sneak peak at the next ver-
sion of OFFICE. He promises to demon-
strate how it will make your work easer.
This presentation will have lots of demos
and show off multiple hardware devices,
including a TOUCH COMPUTER. After
the meeting we can ask him what all those
letters mean!

DACS meetings are held at the
Danbury Hospital auditorium. (Go to
www. dacs.org to find directions and park-
ing info). Activities begin at 6:30 p.m. with
registration and casual networking. The
meeting starts at 7:00 p.m. with a Q&A
period (Ask DACS), followed by an-
nouncements and a short break. The fea-
tured  presentation begins at 8:00 p.m. The
meeting is scheduled to adjourn at 9:30
p.m. DACS General Meetings are free and
open to the public. Members and prior
attendees are encouraged to extend invi-
tations to anyone interested in this topic.
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Special Interest Groups

SIG NOTES: December 2012SIG NOTES: December 2012SIG NOTES: December 2012SIG NOTES: December 2012SIG NOTES: December 2012
Access. Designs and implements solutions using
Microsoft Access database management software.
Contact: Bruce Preston, 203 431-2920 (bpreston @dacs.org).
Meets on 2nd Tuesday, 7p.m., by virtual connection.
Next meeting:  Dec 11  (check Website for technical
details)

Apple. Focuses on all aspects of the Mac and iPhone
operating systems.
Contact: Richard Corzo (macsig@dacs.org).
Meets 1st Thursday, 7 p.m. at DACS Resource Center.
Next Meeting: Dec 6

Digital Imaging. All about digital cameras, retouching, and
printing using various programs.
Contact: Ken Graff at 203 648-9747 (thedigitalwiz@gmail.com).
Meets last  Wednesday, 7 p.m.at the DACS Resource Center.
Next Meeting:  On hiatus until April, 2013

Drupal. Covers all things on Drupal, the open source
content management system (CMS).
Contact: Jim Scheef (jscheef@dacs.org).
Meets on the second Thursday at 7:00 p.m. at the DACS
Resource Center, or go to the DACS Community Forum (http:/
/www.dacs.org/forum/) within the Members  only area.
Next meeting: Dec 13

Jobs. Networking and  jobs search
Contact: Charles Bovaird, 203-792-7881 (aam@ mags.net).
Go to DACS Community Forum (http://forum.dacs.org for
job listings.

Linux. Provides Help in installing and maintaining the Linux
operating system.  Also of interest to Apple owners using
OS X.
Contact: Dave Mawdsley, linuxsig@dacs.org
Meets 3rd Wednesday, 7:30 p.m. at the DACS Resource
Center.
Next Meeting: Dec 19

Mobile Devices. Focuses on smartphones, tablets, and e-read-
ers of all makes and models.
Contact: Richard Corzo and Jim Scheef (Mobilesig@dacs.org)
Meets 4th Thursday, 7 p.m. at the DACS Resource Center
Next Meeting: Jan 24

PC Maintenance. Review of PC hardware and OpSys
maintenance and use.
Contact: Charles Bovaird, 203-792-7881 (aam@ mags.net).
Go to DACS Community Forum (http://forum.dacs.orgl.

Server. Explores Back Office server and client applica-
tions, including Win NT Servers and MS Outlook. SIG is
on hiatus and presently merged into the Drupal SIG.
Contact: Jim Scheef (jscheef@teleAprksys.com), or go
to the DACS Community Forum: http://www.dacs.org/fo-
rum/, within the Members-only area

Web Design and DTP. Learn about Adobe software for
web, graphics and desktop publishing.
Contact: Annette van Ommeren (avo@annagraphics.com).
Meets 3rd Tuesday, 7-9 p.m. at the DACS Resource
Center.
Next Meeting: Dec 18

Let’s join heads!
Do you have a special technology
interest you would like to
share or learn more
about? Join a
DACS SIG or
start one. You
don’t have to
be a nerd or
a guru —
just have a
curiosity
for what’s
out there

and an interest in sharing or discover-
ing with others like you. Just send

an e-mail to dacsprez@
dacs.org, or talk to

one of our offic-
ers at the next
meeting, and
say something
like “I want to
start a SIG!” or
“Wouldn’t it be
nice if we had

a SIG on . . .?”
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General Meeting
7:00 PM

Apple
7:00 PM

Richard Corzo
macsig@dacs.org

Board of
Directors
7:00 PM

Drupal
7:00 PM

Jim Scheef
860-355-0034

MS Access
7:00 - 9:00 PM
Bruce Preston

bpreston@dacs.org

Web & Graphics
Design

Annette van
Ommeren

7:00 - 9:00 PM
avanommeren

@dacs.org

Linux
7:00 -9:30 PM
Dave Mawdsley

linuxsig@dacs.org

Mobile Devices
7:00 PM

Jim Scheef &
Richard Corzo

mobilesig@dacs.org

DACS.DOC
Deadline

Cancelle
d

December 2012
Danbury Area Computer Society
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Ask DACS

November 2012
Moderated  and reported by Jim Scheef

WE WELCOME QUESTIONS FROM the floor at the start of our General
Meetings. The role of moderator is to try to guide the discussion to a likely
solution to the problem.In addition, members who are not able to attend the

General meeting may submit questions to askdacs@dacs.org. We will ask the
question for you and post the reply in dacs.doc and on dacs.org. Please provide as
much information as possible, since we can’t probe during the session.

Q – Has anyone installed Windows 8
and what are the impressions?

A – One member (Richard Corzo) said that
he has installed the download version
of Win8. He used the 32-bit version
because there was no 64-bit driver
available for his scanner. He had to
download the driver for the Sound
Blaster sound card in this desktop
computer, as it was not on the Win8
DVD. Richard made the point that
Windows 8 is “different” in that the
Start Menu has been replaced by the
Start Screen – menu items are replaced
by colored tiles, some of which are
dynamic and display information. His
suggestion was that if you don’t think
you will like the new user interface,
then stay with Windows 7 and save
the cost in time, effort and dollars
required to upgrade. This started a
healthy discussion, which is covered
in the following questions.

A review of Windows 8 is
beyond the scope of Ask DACS, but
some basic facts are needed to
understand the discussion. Leading
into these questions it helps to
understand that Win8 has two
“environments.” The old desktop is
sti l l  there and the regular
applications that we run on older
versions of Windows are displayed
on this desktop, however there is
no ‘Start’ button. The new (Metro)
interface is a screen of colored
squares and rectangles called tiles
that replaces the start menu we have
known since Windows 95. These
tiles replace the shortcuts in the
Start Menu that launch applications.
Clicking on the tile of a Metro (the
code name used at Microsoft for the
new interface) ‘app’ launches a
program that fills the entire screen,
no matter how large your monitor.
Win8 comes with Metro versions of

many familiar applications as well as
new. There are both traditional and
Metro versions of Internet Explorer.

Q – How easy or difficult will the
“typical non-computer-savvy” user
find the transition to Win8?

A – Easy and difficult are relative terms,
and the answer is always “it
depends.” First, let’s agree that
“user friendly” is what you know.
Once you understand how a
program or a user interface (UI)
works, you adapt and after a while,
it becomes second nature. At that
point it becomes “user friendly.” I
believe those who remember the
transition to Win95 will agree.
Richard voiced the position that the
transition to Win8 will be difficult
because when you first look at the
Start Screen, it is not immediately
obvious what to do. I disagree.
What could be more obvious than
to click on the tile for the program
you want to run? To his point, there
are “magic corners” on the screen
and there is nothing on the screen
to indicate how these work after the
hints that play during installation.
However,  there are only four
corners, and you learn what is where
pretty fast. I suggested that the Win8
“experience” is better if you use a
Microsoft account as the login. Again,
this is not obvious, and Microsoft
would likely get in more anti-trust hot
water if they were to make this even
“recommended.” The account can be
a Hotmail, Live, or other Microsoft
login and password. Doing so
activates many of the Tiles on the start
screen. News will show your news
categories; Weather will  show
weather at your location; Mail
shows the number of waiting
messages, etc.

Q – Has anyone heard of limitations
using multiple monitors with
Win8, due to the tablet or touch-
screen orientation of the UI?

A – Richard said that he had read of
‘issues’ due to the magic corners;
but this will be a good question for
Jay Ferron, our December speaker,
who will talk on Windows 8.

D – Richard also mentioned a Logitech
touchpad (tinyurl.com/bp6tolp) to
replace (or supplement?) a
traditional mouse. The videos on
the Logitech website give a good
idea how their products work with
Win8. Sure, touchscreen devices are
available – at a price. Touchscreen
monitors, laptops and all-in-one PCs
are all available, but are not cheap.

Q – Is there a way to get the
‘traditional’ start  menu in
Windows 8?

A – Of course! Many developers have
produced programs that give you a
start button and pop-up menu. With
the caveat that I have tried only one
of these, here are some menu
programs and a registry hack. The
programs attempt to add a start menu
on top of the Metro interface. Some
provide additional fancy features and
tweaks. Many of these were
developed and tested on the preview
editions of Win8, so they may, or may
not, work as planned on the retail
version.

1. Registry Tweak (tinyurl.com/
dyml5wf) disables Metro interface
and returns the menu.

2. Windows Start Menu Vistart
8 (lee-soft.com/vistart) works with
Win7, Vista and XP as well as Win8.

3. Stardock Start8 (tinyurl.com/
6tkkmgy) Another start menu pro-
gram.

4.Power 8 ( t inyurl.com/
cucnzmw) – from Kiev. You might
want to try this in a throwaway in-
stallation.

5.Pokki (pokki.com) – found this
in a David Pogue column in Win8
(tinyurl.com/9ammrk7) and tried it
using the Consumer Preview edition;
it worked well, but I will try others.

Q – I found that my Nook Tablet does
not have the copy and paste function
that we commonly use almost
everywhere else. I often find this
annoying. How common is it for an
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Android device to not offer copy and
paste? For instance, does the Kindle
tablet have copy and paste?

A – In the absence of a response from
the audience, I offered that both of
my Android devices,  an Asus
Transformer tablet and a Droid 3
phone, have the copy and paste
function; however, the implement-
ation is different on each device. A

member offered that in many cases
it is the app that does or does not
support copy and paste.

Q – Does anyone know of a website that
shows what areas have power?

A – The CL&P website (cl-p.com) has a
map showing power outages by town.
The map was available the day after
the hurricane.

[Disclaimer: Ask DACS questions
come from members by email or from the
audience attending the general meeting.
Answers are suggestions offered by
meeting attendees and represent a con-
sensus of those responding. DACS of-
fers no warranty as to the correctness of
the answers and anyone following these
suggestions or answers does so at their
own risk. In other words, we could be
totally wrong!

WHEN YOU USE Microsoft Office,
you create and edit text all the
time. Word, of course, is domi-

nated by text; Excel and PowerPoint both
use text in many of their functions. All
recent versions of Office also include a
tool called a "text box" for special uses
of text. Let's find out what it is and how
to use it.

A text box is a specialized shape in
which you can enter text. It functions
outside the regular margin constraints
of a document and can be moved or
resized as needed. A text box is useful
for adding a caption to a photo or anno-
tating a diagram or chart. If you want to
emphasize an important statement in a
document, you can use a text box to re-
peat the statement in a "pull quote" and
locate it in an unexpected spot, such as
along a margin (known as a Sidebar) or
across columns in the document. Its flex-
ibility makes a text box useful in many
situations.

Text boxes have most of the same
properties as shapes. In Word 2007 and
2010, when you click the Insert tab, then
Text Box, you open the Text Box gallery
of 36 preformatted text boxes, as well as
the "Draw text box" option. If one of the
preset boxes meets your needs, click to
insert it into the document. Older ver-
sions of Word lack this gallery, but you
can still draw a text box, which is most
often my choice. Click "Draw text box"
at the bottom of the gallery. Then click
anywhere in your document where you
want the text box to appear and drag di-
agonally down the page to the right to
create the text box. At first the box cov-
ers a portion of the normal text. This is
because the default text wrapping set-
ting is "in front of text." If you don't want
the text box to hide the document text,

select the text box so "handles" appear
around the box. At this point, the Text
Box Tools Format tab appears on the rib-
bon. Click Format, and then Text Wrap-
ping in the Arrange group. Change the
setting to Tight, which will position the
text box within the existing text and also
allow you to move the text box. Do this
by clicking an edge so a crossed arrows
icon appears and dragging it to a new
location. You can also resize the box by
dragging an edge or corner. To enter text
in the box, replace the informational text
with your own.

Once a text box is created and located
in the document, it can be formatted in
many ways. To format the text, select it,
and a small version of the Font group on
the Home tab will appear. Use these tools
to change the font style, size, color, and
other attributes. (You can also click the
Home tab and use the full set of options
in the Font group.) To format the text
box itself, select it and use the tools on
the Text Box Tools Format tab. For ex-
ample, you can fill the box with a color,
remove or change the border styles,
make the text read vertically, or add spe-
cial 3-D effects.

In Office 2007 and 2010, text boxes
are not limited to a rectangular shape.
You can add text to any of the items in
the shapes gallery. Click Insert - Shapes
and click a shape. Click in your docu-
ment and draw the shape in the same way
you drew the text box. Change the text
wrapping to Tight as you did above, then
right click inside the shape and choose
"Add Text". The large number of shape
choices gives you many options for text
boxes. Another approach is to begin
with a classic text box, even after it is
filled with text. Select it, which opens the
Text Box Tools Format tab. Click Format

and select "Change shape," which opens
the shapes gallery. Click a new shape,
and the text box transforms into that
shape with all its contents intact. An-
other interesting possibility is inserting
a photo or piece of clip art into a text
box. With the text box or shape selected,
click the Insert tab - Picture. Click the
photo you want, then Insert. The photo
appears in the text box, resized to fit. The
same steps work to insert clip art, charts
or tables within text boxes.

Text boxes can be rotated for a dra-
matic effect. In Office 2010, select the
text box, and click and drag the little
green rotator circle above the box to ro-
tate it left or right. In Word 2007, for an
unknown reason, classic text boxes can-
not be rotated, even though shapes can.
One way to work around this problem is
to create a text box, cut it using the Cut
command on the Home tab, and then
paste i t  as a "Picture (Windows
Metafile)" using the Paste Special com-
mand option under the Paste icon.

Occasionally, you might create a text
box in Word that you'd like to reuse at a
later time. You can save it by selecting
the text inside the box and then clicking
Insert and the arrow under the Text Box
icon. Choose "Save Selection to Text Box
Gallery."

Besides Word, text boxes appear in
Excel and PowerPoint 2007/10. Neither
program contains a text box gallery, but
each has the "Draw a Text Box" tool,
which gives you all the functions that
Word does, including rotation. You can
also start with a shape and include text
by right clicking and using the "Edit
Text" command.

Have a little fun. Create a few text
boxes in your next document, spread-
sheet or presentation.

NANCY DEMARTE is a regular columnist (Office
Talk), Sarasota PCUG, Florida (www.spcug.
org; ndemarte @ Verizon.net).

This article appeared in the September 2012
issue, Sarasota PC Monitor, and is distributed
for reprint by user groups.

Word Processing

Get creative with Text Boxes
By Nancy DeMarte
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Candidates

 Richard Corzo  (incumbent)  –  Richard Corzo (incumbent) – Richard Corzo has been a computer
programmer for over 30 years starting on IBM mainframes and working his way down to personal
computers and now doing web applications. He's been a PC user and DACS member since 1993, a
Mac user since 2000, and has written many articles on operating systems and utlilities for the DACS
newsletter. He has been leader of the Macintosh/Apple SIG since the spring of 2004, and is interested
in keeping DACS current with the latest technology. In April, 2010, Richard became DACS president.

Richard Teasdale  –  Richard Teasdale is retired from a long career in Information Technology during
which he played various roles, ranging from Programmer to Project Manager, Systems Analyst to
Unix Administrator. He began his career programming mainframe computers but more recently worked
on servers and PC's. He currently does website support work as a volunteer for a number of non-
profit organizations. A long-time resident of Ridgefield, Richard moved to Danbury in 2010.

A member of DACS for several years, Richard now serves as copy editor for the newsletter and
website, and has recently assumed responsibility for monthly press releases sent to area publica-
tions and media stations. A Drupal user, he is endeavoring to assist with development of the DACS
Drupal website. Since October 2012, he has served out the board term vacated by Rob Limbaugh.

David Green (incumbent)  --  A longtime member of DACS, Dave is the current DACS treasurer.  He
worked on IBM mainframes as a systems programmer and systems analyst for many years.  Since
retiring in 2001 he served as treasurer of the Connecticut Choral Society for six years and as treasurer
of DACS for two years.  He was born in Michigan and has three children and seven grandchildren.
A resident of Danbury for 32 years, he established the 501(c)(3) status of his local homeowners
association.  He plays trombone in the Danbury Community Orchestra and the Danbury Trombone
Outfit.

Bill Saturno  –  Bill Saturno is a lifelong technology enthusiast and retrocomputing hobbiest. He has
been a member of the Connecticut PC Users' Group in Norwalk and CreativeTech, an association of
technology professionals, and is a co-founder of Danbury Hackerspace and Connecticut Hackerspace.
He would bring to the board an extensive experience in online networking and video conferencing.

Bill is currently working as Senior Account Executive at D&R/Boar's Head Provisions, with past
experience in the cellular/digital data industry, as well as experience in NYC dot com startups.
Previously, he served as Promotions and Marketing Director of WRKI/WINE/WAXB/WPUT.

Andy Woodruff  (incumbent)  –  Andy Woodruff has been on the DACS Board since 2010 and a DACS
member since 1991. He also has previous experience on the boards of nonprofit organizations of
various sizes. He served five years as a Board member and Chair of the Finance Committee at an
organization that is much larger than DACS and runs a 7-figure budget (www.rowecenter.org). He
also chaired the startup committee that wrote organizational bylaws and obtained IRS 501(c)(3)
status for a new nonprofit organization (www.ctswing.org). Andy has dual careers as an engineer
and professional cellist, both on a contracting basis. He is a licensed Professional Engineer and has
degrees in physics and electrical engineering from Brown University and Rensselaer Polytechnic
Institute. Andy participates in the Web Design, Drupal, and Digital Imaging SIG’s.
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I (we) hereby appoint Bruce Preston or Charles Bovaird proxies to vote in my (our) stead at the
Annual Meeting of the members of the Danbury Area Computer Society, Inc. to be held on Tuesday,
December 4, 2010 at 7:45 p.m. as follows:

The election of the following to serve as directors for a term of two years and until successors shall
be elected and shall qualify (vote for no more than six):

• Richard Corzo • Dave Green

• Bill Saturno • Richard Teasdale

   • Andy Woodruff

   • ________________

Signature(s): ________________________ / _______________________________

_________________________/ _____________________/______________________

(Membership in DACS is a family membership. If there is more than one member in your
household, all please sign.)

Signed  __________________________________                        Dated __________

The Annual Meeting of the members of the Danbury Area Computer Society, Inc.
will be held at the auditorium of the Danbury Hospital, 24 Hospital Avenue, Danbury,
Connecticut on Tuesday, December 4, 2012, at 7:45 p.m. for the purpose of electing
directors. The number of directors is fixed at ten individuals in two alternating classes
of  five. Each class serves for a term of two years. The individuals named above have
agreed to stand for re-election or election to serve until the Annual Meeting of the
Members to be held in the year 2013.

If you do not plan to attend the meeting, please return the attached proxy to:

Danbury Area Computer Society
4 Gregory Street, Danbury, CT 06810-4430
to arrive prior to December 4, 2008 and express your preferences.

Your presence in person and participation in the meeting would be appreciated.
Come and hear not only what we did this year, but what, with your help, we hope to do in
the coming year.

Respectfully,
Bruce Preston, Secretary

Notice of the Annual Meeting of
Danbury Area Computer Society, Inc.

to be held at 7:45 p.m.
Tuesday, December 4, 2012

Ballot



Future Events:

When you come to the next DACS meeting,
why not bring a friend?

Voice
  for
Joanie

Help give the
gift of speech

Call Shirley Fredlund
at 203 770-6203

and become a
Voice for Joanie

volunteer
www.voiceforjoanie.org

dacs.doc
Danbury Area Computer Society
27 Ole Musket Lane
Danbury, CT 06810-8232

JJJJJanananananuaruaruaruaruaryyyyyDecemberDecemberDecemberDecemberDecember
Jay Ferron
Windows 8

Marc Polansky
Computers and

Astronomy
Wednesday, January 2 –

Check for updates

FFFFFeeeeebrbrbrbrbruaruaruaruaruaryyyyy
Drew Kwashnak
Cloud Storage

Services

MarMarMarMarMarccccchhhhh
Toni McKeen
Genealogy
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